
ATTENTION DESIGNERS 
 
Superelevation Notice: The Policy on Geometric Design 
of Highways and Streets (AASHTO) 2004 has revised the 
guidelines for Superelevation Design.  The present CDOT-
Workspace does not contain the revised criteria.  Therefore, 
until further notice, all Superelevation calculations must be 
preformed by hand based on the latest design guidelines.  
DO NOT rely on the InRoads Superelevation calculations.  
The Superelevation tables are presently being updated to 
reflect the AASHTO 2004 changes and will be rolled out to all 
CDOT InRoads users as soon as this change is complete. 
 
Sight Distance Notice: The default Headlight Site Distance 
Object Height is hard coded into the InRoads Software 
“Vertical Design Calculator”.  The Object Height default is 
being set to 0.5 ft, however The Policy on Geometric 
Design of Highways and Streets (AASHTO) 2004 design 
guidelines updates this value to 2.0 ft.  

 
 
 
 
 
 
 
 
 
 
 

 
In the “View Vertical Annotation” dialog box, the target height 
always displays at 2.00 even if the value in the above 
procedure has not been changed.  Make sure to follow the 
above Sight Distance procedure. 

 
 
 
 



Specialty Group Details 

CADD Website - Library Details

Did you know that the CADD Website includes Specialty Group MicroStation Details 
that can be downloaded and used on your projects?  These Details are being drawn on 
appropriate levels utilizing CDOT Workspace Standards.  Designers can submit details 
to your Team Region Representative for review and approval and then details will be 
included on CDOT Website for use by others.

 
Click Here  to review your Team Member.



MicroStation
CADD Library Details

Did you know that CADD Library Details are being collected?  The Details need to be drawn on appropriate levels, 
utilizing CDOT Standards.  Designers can submit details to Region Representative for review and approval and then 
details will be included on CDOT Web site for use by others.   Submit the drawings to the CADD Manager upon 
completion.
 



General
CDOT Design Guide

Just a reminder, did you know that the CDOT Design Guide 2005 is available at the 
following link: CDOT Design Guide 2005 under the Manuals section (CDOT Design Guide 2005). This 
design guide supersedes the 1995 guide.  You will find this guide to be extremely well written and a very 
useful tool.
 

http://www.dot.state.co.us/DesignSupport/Design%20Guide%2005/Index.htm


   

 

CDOT 

1. INTRODUCTION 
Cell libraries contain cells which represent symbols, patterns, details and 
terminators that are available to all users. Cells eliminate the need for each user to 
redraw frequently used information over and over. 

MicroStation has two different kinds of cells, point cells and graphic cells. The 
major differences between the two types of cells are as follows: the symbology 
(level, color, style and weight), the behavior of the cell when the view is rotated, 
snap points on the cells and flexibility of external system resource files.  

Graphic Cells 
• When the cell is placed it retains its symbology. In other words, if the 

elements in the cell were drawn in color=3, style=1 and weight =2, the 
same symbology will be used when the cell is placed in the file. 

• Graphic cells rotate with respect to the view. 

• All elements of the cell are snappable. 

• They are not ‘tied’ to system resource files. Attribute and database linkages 
can be attached to them.  

• Graphic cells can be very complex and include data fields. 

Shared Cells 
A cell can be placed as a “Shared Cell”. A shared cell is stored in the DGN file. 
To place the same cell in the future, the cell library does not need to be attached.  

Point Cells 
• Point cells take on the current symbology settings when placed into a DGN 

file. 

• Point cells do not rotate when the view is rotated. 

• Point cells are only snappable at their origin point. 

Pros and Cons 

Graphic Cell 
• A cell has to be created for every situation. For example, if there are levels 

for Storm Drains and Electric Lines and you need a manhole. A manhole 
cell must be created using the symbology of that level. If a point cell is 
used, the user can use one cell taking on the active symbology of the 
needed level. 

• All elements of a graphic cell are snappable.  Graphic cells should not be 
used in situations where the cell is placed and the coordinates of that cell 

 



 
 

 

are need in the future. Mistakes are bound to happen due to the whole cell 
being snappable. 

• Each time a graphic cell is placed in the dgn file, the library definition is 
stored in the design file resulting in an increase in file size.  

Point Cell 
• Only one cell needs to be created for many situations. 

• Point cells are only snappable at their origin. Control points, elevation 
spots, etc should be created using point cells. 

• Point cells do not rotate when the MicroStation view is rotated.  

o BHI created a MDL called Pcell2Gcell.ma that can be used to 
change Point cells to graphic cells if the cell needs to be rotated 
in the view. 

Summary 
CDOT’s cell libraries should have both graphic and point cells available. The key is 
to determine when the cell is going to be used and how that cell will be viewed in 
the plan set drawings.  



Changing From UCS to WCS in AutoCAD 
This workflow could be useful for Corridor projects or mapping that was received by outside 
Agencies (Cities, Counties, other consultants) where other phases of the project are in AutoCAD 
and need to be referenced into a MicroStation project, but continually come into the wrong 
coordinate system when referenced.  It may be due to a User Defined Coordinated System (UCS) 
within AutoCAD which may need to be updated to a World Coordinate System (WCS). 
 
 
Here is the workflow to change the UCS back to the WCS.  Go to the item below in AutoCAD. 
 

 
 
 
 
 
 
 
 
 
 
 
 



 
That brings up the dialog box: 
 

 
 
 
Highlight World and Set Current.  That brings you back to the default WCS and Save the file 
when you exit AutoCAD.  Then reference as required into MicroStation. 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Check Color Table, reset if need be.  Color 1 is blue in MicroStation not Red. 



 
Update levels from Library if there is an Asterick next to the level. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Compress the design file with the compress options all turned on. 
 
Make sure to do a file save settings before exiting the file.  This will save the Color Table changes. 



Function Keys — How to Control and Benefit from them  

MicroStation provides a number of tools that can aid any designer to increase the speed and accuracy of 
design work. One of these is function keys. They offer a quick way to accomplish many tasks and are very 
easy to configure and change. 

The basic concept of function keys in MicroStation is to associate a key-in command or a series of key-in 
commands to a function key on the keyboard or a combination of a function key and the “Shift”, “Alt” and 
“Ctrl” keys. This gives you 96 unique combinations. Since almost anything can be done with key-in 
commands in MicroStation, the possibilities for their use are only limited by your imagination. 

After a default installation of MicroStation, a standard function key menu is loaded when MicroStation is 
started. To find out which function keys are mapped and the commands they are mapped to, click on the 
“Workspace” pulldown menu on the main MicroStation menu bar and select “Function keys…”. This opens 
the “Function Keys” dialog box as shown below. 

 

Notice that the name of the file which defines the values in this dialog box is displayed in the title bar at the 
top. Funckey.mnu is the default menu file name.  The file is located in the: C:\Program Files\Workspace-
CDOT\Standards-Local\Users\”individual user’s name” in the CDOT Configuration. 

Any function key combination that is currently being used is listed in the display area at the bottom of the 
dialog box. To see all the values you can simply scroll down the list. If you notice a missing function key or 
combination it just means that it has not been defined yet. In the image above you can see that function key 
“F1” is assigned to the key-in command “help”. That’s why when you hit the F1 key the MicroStation help file 
opens up. The “F2” key in the image above is assigned to a series of two key-in commands. If you look 
closely you can see they are separated by a semicolon (;). The semicolon is the character you use to 
separate multiple key-in commands entered on a single line. The MicroStation key-in “dialog reference” 
opens the reference file dialog box. The second key-in “reference display design” makes sure the reference 
file dialog displays the vector reference file attachments. As a note I have the “Shift-F2” combination 
mapped to “dialog reference;REFERENCE DISPLAY RASTER”. This allows me to quickly change between 
raster and vector reference display, which is something I frequently do. 

The area at the top of the dialog box labeled “Shortcut Keys” is used to designate the function key you want 
to view, change or define. The check boxes next to “Ctrl”, “Alt” and “Shift” can be clicked on or off 
independently in any combination. The “Key” drop-down button to the right of these check boxes and labels 
has the choices “F1” through “F12” representing each of the function keys on your keyboard. By clicking on 
the appropriate check boxes and selecting a function key in the “Shortcut Key” section, you can view that 



combinations current value, click the delete button at the bottom of the dialog to remove it’s current 
assignment or use the “Edit” button to change its existing value or create a new value if it is currently 
undefined. 

As a simple example of how function keys can save a lot of time in doing repetitive tasks, let’s set up the 
function key combination “Shift-F11” so that when pressed, it will close all view windows, then open view 
one maximized and fit the view. This could be used as part of setting up deliverables to meet a client’s 
standard. To start you would want to work out the key-in commands required to accomplish the above and 
test them manually to make sure they worked. The string that we will use to do the above is. 

“view off all; view on 1;window tile;fit all;selview 1” 

Now open the “Function Key” dialog as described above and click on the “Shift” checkbox and select “F11” 
from the drop-down button. If this combination is being used it will highlight in the display box in the bottom 
section of the dialog box. If it is not defined you will see (undefined) next to the label “Current”. In either case 
click the “Edit” button. This opens the “Edit Key Definition” dialog box. Now type the key-in string from above 
into the “New” field. Keep in mind that there is a 56 character limit in entering key-in commands in this 
dialog. In another tip I will show you how to overcome this limitation, but for now, when the string is entered 
click the “OK” button to close the dialog. When you are done making changes to the function key list click 
the “OK” button on the main “Function Key” dialog box. 

Clicking the “OK” button will bring up an “Alert” dialog box asking the question, “Save changes?”, with three 
choices: “Yes”, “No” and “Cancel”. “Yes” saves the changes to the file listed at the top of the “Function Keys” 
dialog box. “No” closes the dialog box with your changes active for the current session but does not save the 
changes you made to the file. “Cancel” returns you to the “Function Keys” dialog box. 

As a final note the main “Function Keys” dialog box has a “File” pulldown menu that allows you to “Open”, 
“Save As” or “Save” function key menu files. If you create a new menu file and open it remember that it will 
only remain active in the current session unless you update the value of the MS_FKEYMNU environment 
variable to point to this new file and in the CDOT Configuration this is not an option. 

 



MicroStation
CADD Library Details

Did you know that CADD Library Details are being collected?  The Details need to be drawn on appropriate levels, 
utilizing CDOT Standards.  Designers can submit details to Region Representative for review and approval and then 
details will be included on CDOT Web site for use by others.   Submit the drawings to the CADD Manager upon 
completion.
 



CADD Manual 
MicroStation and InRoads Key-Ins 

Did you know that the new CADD Manual contains two reference documents 
that may be of particular use to those that use Key-Ins?  These documents attached 
below are called MicroStation Key-in Reference and InRoads Key-in Reference. 
They can also be found in the CDOT CADD Design Manual under Chapter Six,
Drafting Guidelines, 6.6 Key-Ins. 

http://www.dot.state.co.us/ECSU/Manuals/CDOT_CADD_Manual/CDOT_CADD_Manual.htm


MicroStation Keyin Reference   

 

Version Release CDOT 1 
 

MICROSTATION KEYIN REFERENCE 
This document provides a MicroStation alternate keyins. 
These keyins can be typed into the Key-in Browser individually or strung together by a 
semicolon.  

 
 
 

Angle 
AA= Sets the active angle 
 
Auxiliary Coordinate Systems 
AD= Places relative data points 
AX= Places absolute data points 
PX= Deletes an ACS 
RX= Attaches an ACS 
SX= Saves the current ACS 
 
Cells 
AC= Sets the Active Cell and activates the Place 
Cell tool 
AP= Sets the active pattern cell  
AR= Sets the Active Cell, and activates Place Cell 
Relative  
CC= Create Cell from fence or selection set 
CD= Delete Cell from attached cell library  
CM= Creates an array of cells  
CR= Rename a cell in the attached cell library 
LT= Sets the active line terminator cell  
PT= Sets the active point used with the Place Point
command. 
RC= Attaches a cell library 
 
Color  
CT= Attaches a color table 
 
Dimensioning 
LD= Sets the level for dimension data 
TV= Sets the dimensioning tolerance limits  
 
Element Symbology 
CO= Sets the active color 
LC= Sets the active line style 
WT= Sets the active line weight  
 
 
 

 
 

Files 
EL= Creates an element list file  
FF= Copy the contents of a fence to a new or 
existing file  
RD= Open another design file  
RF= Attach a reference file  
SF= Move the contents of a fence to a new or 
existing file  
XD= Exchanges the active file with a reference 
file 
 
Grid  
GR= Sets the active grid reference spacing  
GU= Sets the distance of the grid dots in working 
units  
UR= Sets the unit round off  
 
Line Terminators 
LT= Sets the active line terminator cell 
TS= Sets the scale factor for the active 
terminator 
 
Levels 
LV= Sets the active level  
OF= Turns levels off  
ON= Turns levels on 
 
Patterns  
AP= Sets the active pattern cell  
PA= Sets the pattern angle for pattern cells 
PD= Sets the spacing between patterns  
PS= Sets the active pattern scale  
 
Precision Input 
DI= Places a data point at a given distance and 
direction  
DL=Places a data point at a given X, Y and Z 
distance along the design axes 
DX= Places a data point at a given X, Y and Z 
distances along the view axes  
XY= Places a data point using absolute 
coordinates  



 
MicroStation Keyin Reference 
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Scale 
AS= Sets the active scale  
XS= Sets the active X Scale  
YS= Sets the active Y Scale  
ZS= Sets the active Z Scale 
 
Stream digitizing 
SD= Sets the stream delta  
ST= Sets the stream tolerance  
 
Text 
DF= Opens the Fonts dialog box  
DR= Displays a text file  
FT= Sets the active font  
LL= Sets the maximum line length for text  
LS= Sets the lines spacing for multiple lines of text  
NN= Sets the active text node number  
TB= Sets the tab spacing when importing text  
TH= Sets the text height  
TI= Sets the copy and increment value  
TW= Sets the Text Width  
TX= Sets both the height and width of the text  
 
View Control 
DV= Deletes a named or saved view  
RV= Rotates a view  
SV= Save a view  
VI= Attaches a saved view  
WO= Sets the window origin  
 
View Control – 3D 
AZ= Sets the active depth - absolute 
DD= Changes the display depth - relative  
DP= Sets the display depth - absolute  
DZ= Sets a new active depth - relative 
 
Miscellaneous 
KY= Sets the keypoint snap divisor 
 
 



InRoads Key-in Reference   

 

Version Release CDOT 1 
 

INROADS KEY-IN REFERENCE 
This document provides the InRoads key-ins that can be used with the MicroStation 
key-in browser. 

 
Station key-in formats 
When using alignment station values conventionally there is a plus sign “+” between the 
second and third digits.  InRoads will allow you to input the station with or without the plus 
sign in the MicroStation Key-in Browser and InRoads dialogs. 

 15+15.25 
 1515.25 

 
Slope key-in formats 
When entering slope or grade information in InRoads dialogs and the MicroStation Key-in 
Browser you can use the below formats. 
To key-in a grade of 10 percent: 

 10% 
 1:10 
 .10 

 
Angle key-in formats 
When entering angles in InRoads dialogs and the MicroStation Key-in Browser you can use 
the below formats. 
To key-in a bearing of N12º34’56”E: 

 N12^34’56”E 
 N12.5822E 

 
Plan View key-ins 
 

Northing Easting Elevation (NE=) 
NE=northing,easting,[elevation] 
NE= 2842525.75,1558050.78,11530.47 
 
Station Offset Elevation (SO=) 

 SO=station,offset,[elevation],[alignment name],[project name] 
 SO=1500,-25,0,siderd01,geometry01 
 
 Distance Direction (DI=) 
 DI=distance,direction 
 DI=100,n45e 
 

 
 



 
Sheet File Creation 
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Cross Section and Profile key-ins 
 

Delta Offset (DO=) 
DO=delta,offset 
DO=50,-10 
 

 Distance Grade (DG=) 
 DG=distance,grade 
 DG=200,50% 
 
  
 
Cross Section key-ins 
 

Offset Elevation (OE=) 
OE=offset,elevation 
OE=50,11430 
 

Profile key-ins 
 

Station Elevation (SE=) 
SE=station,elevation 
SE=19+50,11430 
 



 
 

Directions: 
 
I-25 to 6th Avenue///6th Avenue west to W. Colfax   
Left onto W. Colfax///W. Colfax to Corporate Drive 
Left onto Corporate Drive/// Corporate Drive to stop sign 
Left onto Corporate Circle///CDOT building on left side of the street. 



InRoads 

MicroStation File Open and InRoads

Did you know that the File Open command within MicroStation, closes the last 
MicroStation drawing file but does not Exit the InRoads program?  Unlike AutoCAD, 
MicroStation only opens one file at a time, thereby closing the previous file while 
opening the next file.  The File Close option will close InRoads completely, so try the 
file open command instead.
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MULTIPLE ACCUDRAW SHORTCUT FILES 
By Seth M. Cohen, ProSoft NET

  
Is your MicroStation desktop cluttered with toolframes & toolbars?  Are you sacrificing precious 
desktop real estate because “YOU GOTTA HAVE THAT ICON”?  If so, then creating multiple 
AccuDraw key-in shortcuts will let you reclaim your desktop! 
  
What is AccuDraw?  According to the MicroStation/J help, “AccuDraw is a drafting aid that evaluates 
such parameters as your current pointer location, the previously entered data point, the last coordinate 
directive, the current tool's needs, and any directive you have entered via either keyboard shortcuts or 
AccuDraw options. AccuDraw then generates the appropriate precision coordinates and applies them to 
the active tool”.  The topic that we will be discussing is AccuDraw shortcuts. 
 
ACCUDRAW SHORTCUTS 
The functionality of AccuDraw shortcuts is to run MicroStation key-in commands.  This is 
accomplished by the user creating a shortcut to a desired key-in by associating two alphanumeric 
characters to that key-in. 
 
Here is an example of how to create an AccuDraw shortcut, and how they can make drafting more 
efficient, and increase your MicroStation desktop. 
 
Wouldn’t it be nice if…….you could turn off the display of, let’s say, 150 reference files without having 
to: 

1) Open the Reference File Dialog box 
2) Select all the reference files 
3) Click the display toggle on the Reference File Dialog to off 
4) Click the Update All icon to refresh the view 

 
Well with AccuDraw, you could set two shortcuts to toggle all the reference files on and off.  Here’s 
how: 
 
First, we will define two shortcuts that will act like switches.  The shortcuts are, R0 and R1.  R0 would 
turn all reference files off, and R1 would turn all reference files on. 
 
To accomplish this, open AccuDraw by keying in ACCUDRAW DIALOG MAIN, or click the 
AccuDraw icon on the primary toolbar.  When the AccuDraw window appears, press the question mark 
(Shift + /), which will open the AccuDraw shortcuts window (see Figure 1).  Click on the New button.  
When the Edit Shortcut Dialog appears, type in the following data (see Figure 2): 
 
Shortcut – R0 
Description – all ref’s (display) off 
Command – REFERENCE DISPLAY OFF ALL;UPDATE ALL 
Choose OK. 
 
 
 

Figure 2
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For the shortcut that turns on all reference files, click the New button again but replace the Shortcut field 
with R1, and replace “OFF” (in the Command field) to “ON”. 
 
That’s it!  Now, when you want all 150 reference files turned OFF or ON, type R0 or R1. 
 
Here are a couple of tips on using AccuDraw shortcuts: 
1)  For AccuDraw shortcuts to work correctly, the AccuDraw Window will need the “focus”.  To move 

the focus to the AccuDraw Window, the following can be done: 
a. Press the ESC key 
b. Assign the following key-in to a function key:  ACCUDRAW DIALOG MAIN.                                 

Whenever you need focus in AccuDraw, press the Function Key. 
c. To assure that the focus stays in the AccuDraw Window as much as possible, choose Workspace 

> Preferences > Category-Tools, and toggle the Auto-Focus Tool Settings Window OFF. 
2)  MStoys.ma* is an MDL that adds the key-in commands ACCUDRAW ROTATE ELEMENT and 

ACCUDRAW SUSPEND.  These key-in commands rotate the AccuDraw compass to the angle of 
any element and temporarily suspend AccuDraw, respectively. 

3)  You can string commands together by using a semi-colon(;).  Doing this reduces the amount of 
“clicks” or movement that you will have to do with the mouse.  An example of this would be:  
Shortcut - CB, Command - REFERENCE CLIP BOUNDARY;ALL;CHOOSE ELEMENT.  This 
shortcut will clip the boundary of all reference files, after a fence is defined (and you don’t even 
have to open the Reference File dialog or Reference tool box). 

 
*To obtain a copy of this MDL go to the following web address: 
http://www.mindspring.com/~rob.brown/microstation/mstoys/mstoys.html 
 
“HEY SETH, WHAT ABOUT FUNCTION KEYS?” 
Now you might be saying “Why should I use AccuDraw?  I could use function keys.”  Well one major 
advantage of AccuDraw shortcuts is that you can make shortcuts that make sense.  Unlike using 
Function Keys (F1, F2, ALT+CTRL+F1, etc.) AccuDraw shortcuts can “sound” like the key-ins they are 
created for.  For example the Copy command could be CO, the Rotate command could be RO, etc.  Plus, 
you won’t get carpotunnel syndrome from trying to activate the ALT+CTRL+Shift+F8 function key. 
 
LIMITATIONS OF ACCUDRAW SHORTCUTS 
This is not to say that using AccuDraw shortcuts does not have its limitations as well.  One limitation is 
that there is no way to have single letter and two letter shortcuts that begin with the same letter.  In other 
words, you can’t have a shortcut Z and ZW.  Another one of AccuDraw’s limitations is that you can 
only have up to two-character shortcuts.  This limitation can be very frustrating when developing a list 
of shortcuts meant to improve your productivity.  For instance, let’s say you wanted to create a shortcut 
for the Copy command (key-in COPY EXTENDED).  The obvious two-letter shortcut would be CO.  
What if CO were already taken?  And CP?  And CY?  There is no way to get by this limitation of 
AccuDraw’s functionality……….Until now. 
 
MULTIPLE ACCUDRAW SHORTCUT FILES 
This brings us to the main subject of this article.  How can we allow MicroStation to use more than two 
characters for shortcuts?  The answer is simple.  We can create a MicroStation BASIC macro that acts 
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like a switch, and loads another AccuDraw shortcut file for you.  With help from a former fellow 
employee of mine, David Munro, P.E., a Project Engineer at CLD Consulting Engineers Inc. in 
Manchester NH, we created such a macro. 
 
Here is the Macro: 
'Shortcut.bas - Used to Load AccuDraw Shortcut files 
' 
'Assumes custom shortcut files are in location: 
'c:\bentley\workspace\standards\data\ 
'Command syntax: "MACRO SHORTCUT SHORTCUTS" 
'where "shortcuts" is the shortcut file to be called. 
 

1. Sub main 
2. Dim status as Integer 
3. Dim fileName as String 
4. Dim strTemp as string 
5.  
6. MbeSendCommand "NoEcho" 
7.  
8. fileName = Command$ 
9.  
10. strTemp = "c:\bentley\workspace\system\data\" & fileName & ".txt" 
11. status = MbeDefineConfigVar("MS_ACCUDRAWKEYS",strTemp) 
12. MbeSendCommand "ACCUDRAW SHORTCUTS READFILE" 
13.  
14. MbeSendCommand "Echo"   
15. End Sub 

 
You don’t have to be a programmer to understand how the BASIC program is working.  Here is a 
breakdown of the code.  If you don’t care to know, please feel free to skip to the section titled “Getting 
The Files In The Right Place”. 
  

1)  The first three lines (after Sub main) define variables. 
2)  Line 6 is very important for certain shortcuts.  "No Echo" tells MicroStation not to display 

messages like "MACRO <macro file> LOADED " etc. in the message area (any messages in 
the lower right corner).  By disabling the messages from appearing, the user has full sight of 
the current snap mode, selection set count, etc. 

3)  “Command$” is a MicroStation BASIC command that returns a string representing the 
argument from the command line used to start the macro.  In other words, any text entered 
after the key-in " MACRO <macro file>" will get sent to the Command$ string variable, 
which I have equated to fileName. 

 
 
Here is an example. 

Shortcut = C1 
Key-in = MACRO SHORTCUT COLORS 
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This key-in runs the macro shortcut.ba and passes “COLORS” to Command$.  The macro 
then takes COLORS and stores it in the variable cmd. 

4)  Then, we define the variable strTemp to equal the path (default) of the shortcut files, and we 
append (&) the contents of the cmd variable with a TXT extension.  The TXT extension is 
added so we don’t have to type .txt in every AccuDraw shortcut that we use to call another 
file. 

5)  Next we redefine the value of the MS_ACCUDRAWKEYS variable to equal strTemp. 
6)  Then we Send a Command to MicroStation with the key-in ECHO, which re-initializes the 

messages display. 
  
GETTING THE FILES IN THE RIGHT PLACE 
Now we need to look at where to put our AccuDraw shortcut file.  A few questions need to be answered 
first. 
 

1)  Are you running a network setup (i.e. your workspace is located on a server) and users have 
roaming profiles? 

2)  Are you running a localized setup (MicroStation “out of the box”)? 
3)  Will users be responsible for creating their own shortcut files or will one user maintain the 

files? 
4)  Do you wish to stay in the shortcut file that you call, or do you want to revert back to a 

“master shortcut file” once the shortcut loaded is executed (will expand on this later). 
 
Here are some suggestions for implementing multiple AccuDraw shortcut files defined by each setup. 
 
Network Setup using Roaming Profiles and The Master Shortcut File (preferred setup) 
This setup requires that you create and store the AccuDraw shortcut files in the user’s roaming profile.  
This is a great way to allow each user at your site to maintain/create their own shortcut files.  This way, 
each user will create/assign shortcuts that make sense to them.  Additionally, the user can log onto any 
machine in the network (with MicroStation loaded on the machine) and use their shortcut files. 
 
The following is a list of items that will need to be changed/edited: 

1. Initial definition of MS_ACCUDRAWKEYS in a site configuration file. 
An example of this is:  MS_ACCUDRAWKEYS = $(PROFILE)shortcuts/shortcut.txt 
The $(PROFILE) variable, uses the WinNT environment variable $(USERPROFILE) to expand 
the variable definition to c:\winnt\profiles\<user login name>\bentley\shortcuts\shortcut.txt.  Be 
careful if you change over to Windows 2000 Professional, as the $(USERPROFILE) variable is 
defined as c:\documents and settings\<user login name>. 

2. Define the folder location of the Multiple AccuDraw Shortcut files. 
This is up to you where you wish the shortcut files to be located, but I recommend using the 
location that is already defined in step number one.  The folder location defined in step 1 is 
c:\winnt\profiles\<user login name>\bentley\shortcuts\. 

3. Place the macro in a path defined by MS_MACRO 
Usually, a folder(s) exists on the network where macros are placed for all users to have access to.  
This folder is defined by the MicroStation variable MS_MACRO.  An example definition of 
MS_MACRO is: MS_MACRO > $(_USTN_SITE)macros/.  _USTN_SITE expands to 
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$(_USTN_WORKSPACEROOT)standards/.  If you’re not sure of what I am talking about, please 
call me (really, I mean it). 

4. The strTemp variable in the macro. 
In the macro shown above, strTemp is defined as “c:\bentley\workspace\system\data\" & 
fileName & ".txt".  For the macro to find the shortcut files in the user’s roaming profile, we must 
change strTemp to: 
 
strTemp = "$(PROFILE)\shortcuts\" & fileName & ".txt". 

 
You also have the option to place the shortcut files in one location that only a certain group of 
individuals have access to.  Then you can then set network permissions to allow which users will 
maintain and create the shortcut files.  You still have to complete the steps above, except the definition 
of the location folder and the Master Shortcut file (Steps 1 and 2) are set to a folder that all users can 
share on the network. 
 
Local Setup and The Master Shortcut File (using MicroStation “out of the box”) 
The local setup is the easiest of all.  The only requirement is to create/edit the AccuDraw shortcut files 
and place them in the default location defined by MS_ACCUDRAWKEYS 
(c:\bentley\workspace\system\data).  The only other requirement is that you place the macro in a 
location where MS_MACRO is defined (c:\bentley\workspace\system\macros). 
 
What do I mean by “The Master Shortcut File”? 
AccuDraw shortcuts and files can be setup in two ways: 
 

Method 1. Use a master shortcut file, and when the macro is used to switch to another file, each 
shortcut in that “switched file” will be created so that they switch back to the master 
shortcut file. 

Method 2. When the macro is called to switch to another file, the shortcuts in that file will be 
defined so that they don’t switch back to the master shortcut file, rather the user stays 
in the file called and can create a commonly named shortcut in each file that switches 
back to the master shortcut file . 

 
I know, this sounds a little confusing, but it’s REALLY easy to setup.  The table below helps better 
describe this: 
 
Method 1:   

    
Example shortcuts in The Master Shortcut File (shortcut.txt) 
 Shortcut “Description” Command key-in 
 “AR” “Rotate to element” “ACCUDRAW ROTATE ELEMENT” 
 “AZ” “Sets az=0 and dp -5k,5k” “AZ=0;SELVIEW 1;RESET;DP=-5000,5000;SELVIEW 1;RESET” 
 “AT” “Rotate top” “ACCUDRAW ROTATE TOP” 
 “BF” “Wset add” “WSET ADD;WSET DROP;UPDATE ALL” 
 “C1” “Color table shortcuts”  “MACRO  SHORTCUT COLORTABLES” 
 “CA” “Change attributes” “MDL L CHANGEBY;CHANGE ELEMENT EXTENDED” 
 “DI” “Dialogs”  “MACRO SHORTCUT DIALOGBOXES” 
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 “MM” “Macro and mdl shortcuts”  “MACRO SHORTCUT MACROSANDMDLS” 
    
Note the shortcuts bolded.  These shortcuts call other shortcut files via the macro. 

    
Example shortcuts in the dialogboxes.txt shortcut file 
 Shortcut Description Command key-in 
 “CL” "Config variables" "MACRO SHORTCUT SHORTCUT; MDL L CFGVARS" 
 “FK” "Function key menu" "MACRO SHORTCUT SHORTCUT; DIALOG FUNCKEYS" 
 “FN” "Font settings" "MACRO SHORTCUT SHORTCUT; DIALOG FONT" 
 “WU” Working units “MACRO SHORTCUT SHORTCUT; DIALOG UNITS” 
 “ZZ” "Shortcut" "MACRO SHORTCUT SHORTCUT" 
 
Note that all the shortcuts contain the key-in MACRO SHORTCUT SHORTCUT along with the desired shortcut.  
Additionally, the ZZ shortcut serves as an, "oops, I pressed the wrong buttons" shortcut, that restores you to the 
master shortcut file 
 
 
Method 2:   
    
Example shortcuts in The Master Shortcut File (shortcut.txt) 
 Shortcut Description Command key-in 
 AR ROTATE TO ELEMENT ACCUDRAW ROTATE ELEMENT 
 AZ SETS AZ=0 AND DP -5K,5K AZ=0;SELVIEW 1;RESET;DP=-5000,5000;SELVIEW 1;RESET 
 BF WSET ADD WSET ADD;WSET DROP;UPDATE ALL 
 C1 COLOR TABLE SHORTCUTS MACRO  SHORTCUT COLORTABLES 
 CA CHANGE ATTRIBUTES MDL L CHANGEBY;CHANGE ELEMENT EXTENDED 
 DI DIALOGS MACRO SHORTCUT DIALOGBOXES 
 MM MACRO AND MDL SHORTCUTS MACRO SHORTCUT MACROSANDMDLS 
Note the shortcuts bolded.  These shortcuts call other shortcut files via the macro. 
    
Example shortcuts in the dialogboxes.txt shortcut file 
 Shortcut Description Command key-in 
 CL "CELL LIBRARY" "DIALOG CELLMAINTENANCE" 
 CV "CONFIG VARIABLES" "MDL L CFGVARS" 
 CZ "CUSTOMIZE" "MDL L CUSTOMIZ; CUSTOMIZ DIALOG" 
 DF "DESIGN FILE SETTINGS" "MDL L DGNSET" 
 DS "DIMENSION SETTINGS" "DIALOG DIMSETTINGS OPEN" 
 FK "FUNCTION KEY MENU" "DIALOG FUNCKEYS" 
 FN "FONT SETTINGS" "DIALOG FONT" 
 ZZ "SHORTCUT" "MACRO SHORTCUT SHORTCUT" 
 
Note that all the shortcuts contain the key-in MACRO SHORTCUT SHORTCUT along with the desired shortcut.  
Additionally, the ZZ shortcut serves as an, "oops, I pressed the wrong buttons" shortcut, that restores you to the 
master shortcut file 
 
How do I find those key-ins? 
So, how do you find out all those key-ins?  There are many ways to find out key-ins, but I am going to 
cover two, for brevity’s sake: 
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1. An MDL utility called ALTKEYIN 
2. Run the Macro Recorder tool 

 
The first tool is an “Alternative key-in” to the MicroStation Key-In window.  ALTKEYIN extracts any 
MicroStation key-in that you invoke by clicking on an item from the pull-down menus or from clicking 
an icon on a toolbox.  ALTKEYIN “grabs” the key-in and populates the AltKey-In window (see figure 
3). 
 
 
 
 
 
 
 
 
 
 
 
 
 
To copy the key-in from the AltKey-In window: 

1) Put the focus in the AltKey-In field 
2) Press the Up and Down keys on the keyboard to cycle to the desired key-in(s) 
3) Select the text 
4) Press CTRL+C to copy the text to the clipboard.   

Now you can create your shortcut by pasting the command syntax into the command field of the Edit 
Shortcut dialog box.  So, you ask, how do I get a copy of this awesome utility?  E-mail 
info@prosoftnet.com   , and we will e- mail you the free ALTKEYIN utility. 
 
The second way to find your desired key-ins is to run the Macro Record tool.  Here are the steps: 
 

1. Choose Utilities > Create Macro… from the MicroStation pull-down menu 
2. Give the macro a name.  Notice the Record Macro dialog appears (see figure 4) 
3. Choose/pick the commands that you wish to extract  
4. Click the Stop button on the Record Macro dialog to stop the macro from recording 
5. Choose Utilities > Macros and notice the Macros dialog points to the newly created macro 
6. Open the macro to see the key-ins that were invoked 
7. Copy the desired key-ins to the command field of the Edit Shortcut dialog box or create a 

shortcut that runs your newly created macro 
 
 
 
 
 
 
 

Figure 3 

Figure 4 
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Reasons to try AccuDraw 
Implementing AccuDraw shortcuts at your site can increase your productivity two-fold.  I will explain 
this statement with a real life example. 
 
Prior to working with ProSoft, I was a Highway Design Technician / MicroStation & InRoads 
Coordinator, supporting Engineers and Technicians with drafting and minor engineering tasks.  My 
primary work involved Design for the Vermont Agency of Transportation (VTrans), New Hampshire 
Department of Transportation (NHDOT) and Maine Department of Transportation (MDOT).  One of the 
tasks involved with Highway design is making revisions to a set of Roadway Plans that an Engineer 
would mark up (lot’s of red ink).  Although user might find this task tedious and boring, I loved 
performing this task as it involved (for me) the use of AccuDraw shortcuts.  I would challenge myself to 
create as many shortcuts that I needed without using any pull-downs or icons.  This is of course why my 
Master Shortcut file contains approximately 150 shortcuts. 
 
One day, I decided to see if spending all this time creating these shortcuts was truly making me more 
productive, and wasn’t wasting company time.  My test was to take a part of a set of plan sheets, time 
myself and perform all the edits without using any AccuDraw shortcuts (i.e. using pull-downs and icons 
only).  Then, do the same edits using my AccuDraw shortcuts.  I performed these edits on the “Typical 
Sections Sheets”.  Typical sections are a set of plan sheets that show the cross sectional view of the 
designed roadway at major changes.  Here are the results of this test: 
 

1)  Typical Sections with pull-downs and icons only  –  1 ½ hours 
2)  Typical Sections using AccuDraw shortcuts only  –  45 minutes 

 
As you can see from this test, using AccuDraw shortcuts increased my productivity by two! 
 
Conclusion 
Am I saying that you too can increase your productivity two-fold?  Maybe not.  What I am saying is to 
give AccuDraw shortcuts a try and you too will reap the benefits from one of MicroStation’s best tools. 
 
Also, I am providing (free of charge) all my AccuDraw shortcut files and the macro used to switch 
between shortcut files in a convenient ZIP file.  These shortcuts are over 7 years in the making, in 13 
different shortcut files, and  total more than 350 shortcuts in all!  Simply e- mail info@prosoftnet.com   , and 
we will send you the ZIP file. 
 
Take back your MicroStation desktop and increase your drafting productivity today, with the use of 
multiple AccuDraw shortcuts! 
 
Seth M. Cohen is a technical writer for ProSoft NET and has been using MicroStation since 1995.  
He is a certified instructor for the MicroStation CAD Manager class, InRoads, InRoads Site and 
InRoads Survey.  Seth can be reached at scohen@prosoftnet.com     and by phone at 207-781-7000 or 
888-781-7000 (toll-free). 

seth
scohen@prosoftnet.com



Redline 

Opening an Editable Redline File 

Did you know that if a file is opened in a read only mode, then there are only a few 
commands that are allowed in Redline.  It will be very obvious to you as the icons will 
not look anything like the training.  You will be in a "View" only mode.  Also check in 
the lower right hand corner of the screen, to see if there is a Red "X". If so the file is 
being opened as read only. In order to open the file for Redline use, try using Start > 
all programs > Bentley Redline > and select the Bentley Redline executable. You can 
right click on the executable and send to desktop for a shortcut to the command in the 
future. 



Step 3 - Open the previously copied 
project PCF file with Notepad or 
WordPad.  Edit the file on the 
MS_DEF= line to include the Path 
defined by Step 1 above.  Save the file.  
(Note: Make sure to change the 
backslashes to forward slashes) 

Step 4 – The Final step. Open Inroads.  From the 
MicroStation Manager Workspace Project pull-down 
list, select the project configuration file (99999).  Locate 
the design model and click OK.  From the InRoads 
menu select File > Project Defaults.  Key-in the path 
for the desired InRoads design data files (Example: 
\\LargentK\Projects\99999\Design\Inroads - shown at 
left).  Apply and Close the dialog box.  Open desired 
InRoads Design data (DTM’s, ALG’s, TML and RWL 
files) and create or modify the Project.rwk file. Click on 
the InRoads File > Save As.  Select Options.  Check the 
desired boxes, click Ok and save the file.   
 
For additional information, see CADD Web site 
Library, InRoads-Tip Populating InRoads Explorer.

 

Method for connecting to Project Manager’s 
machine.  Including: creating a Shortcut, 

updating Project Configuration File (PCF) and 
setting up Project Defaults within InRoads 

Submitted by Elizabeth Hawkins 

TIPS AND TRICKS 
Additional Tips and Tricks can be found on 
the CDOT CADD Tips and Tricks webpage.  

Step 1 - To open a folder on the Project Manager’s 
machine, go to the Windows Start Menu, select Run… a 
dialog will open, Key-in the appropriate path desired.  
Do not use Browse. Select OK when complete.  
(Example: \\LargentK\Projects\99999\Design shown at 
left) After the folder has opened, Right click on the 
Folder icon in the Address Bar of the Explorer Window 
and drag to the Desk Top, a dialog box will open.  
Select Create Shortcuts Here (Note: Each person 
desiring to work on the project must be given 
appropriate access to the folders they will be working 
with).  The Project Manager should determine the level 
of Access.  The V2.0 CDOT Configuration file 
structure should be used to create the project. 

Step 2 – The Project Manager should email the 
team a copy of the Project Specific PCF, (Example file 
name and location 99999.PCF shown at left).  This file 
should be copied from and placed into the C:/Program 
Files/Workspace-CDOT/Standards-Local/Projects 
Folder located on each team member’s machine. 
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ProjectWise 
 

This document is to provide CDOT users a little background on why the 
Department is moving to ProjectWise, some benefits for users and the 
Department, potential future uses, and finally Guidelines for using ProjectWise. 
 
CDOT is implementing the use of ProjectWise to store and backup project 
information, share data, and provide project managers with additional tools to 
manage their projects.  ProjectWise stores all project documents in one central 
location.  This allows for easy sharing and referencing of documents and 
information.  This is a major change in the way we currently do business.  
ProjectWise also has the ability to archive information:  implementation will be 
investigated in the future. 

��������

�	
����
���������������	�����������
���
����
	���
����	��	�������������������	
����������������	�
���
	����
�����������	��

����
�����������	��

���������	
����
�����	
������
����	���

	���������������	���������
���	��������������
�
	 �	
������	
���������	�������
	����!���
���
	���
����
����
	������
	����!���
�����	
���
�������
�
	��������
	 ������������������������	
����
����������������	
�����������������
��������
�	
�����
�����������	������������	��	
������
	 ��������	
������������������
������	�
��	���
����
	���	������
��������	����	�������

�������������	"�

• ��������	���#������
���������
�������

	������
�����
	��������	
�����������������

• ����	����
	 �	�����������	��������
	����
�����	�����������������
������	�������
���������	�#

�
	 �����������	�$�������������	��������

• �
��������
	 �	����	
��������#��	�
	������������#������
����
	���
����

• %��	������������&��������������������������	�����	���������
������	
���
�����������
������������

• ���
��	���	
�����������	���
��
���
	��	
�	�����
�����
���������	���
���$��� ����
�
��	���	���
���	�����������������

  
CDOT ProjectWise Architecture 
In preparation for the deployment of ProjectWise, numerous infrastructure 
improvements have been implemented.  CDOT has upgraded the useful line 
capacity on the T1 lines to each of the residencies, effectively doubling the 
bandwidth. These upgrades involved upgrading the service on those lines and 
the installation of upgraded routers in 26 residencies.  CDOT is implementing 
ProjectWise on an entirely new hardware infrastructure. New servers are being 
implemented for this project, as well as new storage technology and capacity.  
The ProjectWise Distributed File Servers (DFS) will be located in Region 
headquarters offices in Regions 2, 3, 4 and 5. The Region 1, 6 and HQ DFS will 
be located in CDOT HQ.  This architecture ensures that the project data is 
located in the Region were the project is located and the majority of the work is 
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performed.  Figure 1 and Figure 2 show the ProjectWise server environment the 
File Retrieval process. 
  
Figure 1 – ProjectWise Environment 

 
 

Figure 2 – ProjectWise File Ret rival Process 
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Currently, CDOT shares and recreates a lot of information between project team 
members from CAD drawing files, to reports and permits.  The current workflow 
requires the creator of a document to send it out to team members where they 
then store it on their PC thus creating multiple instances of the same file.  The 
creation of multiple files all over the place has obvious disadvantages of:   

• Is this the latest file? 
• Oops, I just overwrote the one I was supposed to be using.  
•  Incompatible file formats. 
• Too much/too few data, not the data recipient really needs. 
• Locating the necessary project files on different computers. 
• Inability of passing off a project to another user (see above bullet). 
• The creator of the file edits the file and forgets to re-send it out to 

everyone. 
• Someone getting into a document and making changes when they did not 

have the permission to do so. 
ProjectWise will help us more effectively share data and manage our projects 
within a collaborative environment to prevent the above from happening thereby 
streamlining and making the project development process more efficient.   
 
Data managers will create a project in ProjectWise and each specialty group will 
have a folder where they will store their information.  To date specialty advisory 
groups have helped create the folder structure and resulting workflows that will 
be implemented.  These folders have file and directory security set so that only 
the specialty group members in the Region and HQ will have read/write 
permissions, everyone else will have read access.  This is where the power of 
ProjectWise comes into play, because file and directory permissions have been 
set to read access, it allows them to share that information with other project 
team members with out fear the data will be accidentally changed or destroyed.  
The creator of the document can store it in one location, edit and update it as 
required while other team members can reference that file and know they are 
working with the correct and latest information. 
 
Files will be easily accessed by reproduction for printing and advertisement 
needs.   
 
ProjectWise server will be backed up on a regular schedule so the problem of 
losing data due to computers crashing or accidental deletion of files will be 
minimal. 
 
Project Management 
ProjectWise is also a project management tool that will allow CDOT managers to 
access data directly without having to call to get the information.  For example 
check schedules, review reports, reference others files, check on clearances, etc.   
 
ProjectWise Guidelines have been developed to enable CDOT to successfully 
implement this program. 
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ProjectWise Guidelines: 
 

1. Starting in September 2005 all new projects that have a project number 
(i.e. are in ProMIS) will utilize ProjectWise. 

2. All projects currently using MicroStation and InRoads will be transferred to 
ProjectWise. 

3. All project related data will be stored on ProjectWise. 
Note:  E-mail may be added at the end of the project so as to only 
include pertinent correspondence. 

4. Project files will reside in the creators’ directory structure and others will 
reference to it as needed. 

5. A description for what is to be stored where and workflows for each 
specialty group are to be followed and can be found on  the CADD 
Manager’s website: http://internal/CADD/ 

6. No folders can be added or deleted unless submitted to and approved by 
the standards and configuration team. 
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Several Questions have surfaced relative to Training Materials available to the Users.  The future 
purchase of training manuals was discussed with the CEST Steering Committee and it was 
determined that if individuals want additional material outside of what is included under manuals 
on the Webpage, that it would be the users responsibility for purchasing the books.  CDOT does 
not presently have any additional training manuals except for the manual that are received during 
the CDOT Training course.  The new CADD webpage contains several reference guides for 
MicroStation along with the MicroStation/InRoads Help provided with the software.    
 
A few good resources are the following: 
 
The CDOT CADD Website http://internal/cadd/Library/Library.cfm contains several of the 
standard MicroStation User manuals and other information including many tips and tricks and a 
Tip of the day on the Homepage. 
 
Another is the Bentley SelectServices Website, 
http://bentleyinstitute.bentley.com/subscriptions/subonline/content/Everything3D/wwhelp/wwhimpl
/js/html/wwhelp.htm?courseid=TRC501330-1/0001 which has several courses that are self paced 
and at this point are free to CDOT.  At some point it is my understanding that a Log-in will be 
needed, but at this time it is a very good resource at no cost to CDOT. 
 
Check both out.  I'm sure you will find them both useful.  The Bentley 
http://selectservices.bentley.com website requires a password that Bentley will send you once 
you register with them.  This also will allow users to chat with an analyst and many other 
Browsing capabilities.  Let Elizabeth Hawkins know if you have difficulty logging into the site. 
 
There are several other resources that are also good.  One author in particular who has always 
been reputable is Frank Conforti.  His book is Inside MicroStation.  Another book is called 
Harnessing MicroStation by GV Krishnan. Both are available on Amazon.com.  Another site that I 
know of is http://shop.prosoftnet.com/ out of Utah.  They have several manuals to choose from.   
 
Hope this gives you a little better starting point for Reference Material.  Book stores around town, 
may also be able to get the above referenced books. 
 
Happy "CADDing", 
 
 



MicroStation and InRoads
Requesting a new Level or Feature

Did you know that if you want to request a new level or feature in the CDOT Configuration, you should go 
to the CADD Support Tab on this Web Page, select a topic from the CADD Support pull-down and choose 
"Add a Level or Add a Preference".  This will open up an email that will allow you to fill in the appropriate 
boxes and then send it off to the CADD Manager. 



Misc 

Scanned Document Size

Did you know that if  you can reduce the size of a scanned image by performing the 
following.  Scan the documents you want with a high resolution of say 600 dpi, then in 
order to get a smaller file size, print that document to Acrobat distiller. The file size 
will be much smaller.  Thanks Joe Garcia- Region 2 



Misc
Select Services Website Self Paced Courses

Did you Know that The Bentley Select Services Website has several courses that are self-paced
and at this point are free to CDOT.  In the future a Log-In will be needed, but at this time, it is a very
good resource at no cost to CDOT. 

http://bentleyinstitute.bentley.com/subscriptions/subonline/content/Everything3D/wwhelp/wwhimpl/js/html/wwhelp.htm?courseid=TRC501330-1/0001
http://bentleyinstitute.bentley.com/subscriptions/subonline/content/Everything3D/wwhelp/wwhimpl/js/html/wwhelp.htm?courseid=TRC501330-1/0001
http://bentleyinstitute.bentley.com/subscriptions/subonline/content/Everything3D/wwhelp/wwhimpl/js/html/wwhelp.htm?courseid=TRC501330-1/0001
http://www.bentley.com/en-US/Training/


Information concerning Survey Coordinate System 
By Dan Smith 
 
Colorado has a standard coordinate system established by the National Geodetic Survey (NGS) 
and mandated by Colorado state law which is used extensively by CDOT. The coordinate system 
is the Colorado Coordinate System of 1983 and divides the state into three zones, North, Central, 
and South, all consisting of a Lambert Conformal Conic projection of the North American Datum 
of 1983 (NAD 83). NGS refers to the system on a national level as the National Spatial Reference 
System (NSRS).  
 
You will find the specifics for each zone include in the CRS, including counties, standard parallels 
and origin coordinates. It is also important to note that Colorado has mandated the U.S. Survey 
Foot as it's unit of measurement.  
 
Please refer to the following link for each of the following CRS: 
 
http://198.187.128.12/colorado/lpext.dll?f=templates&fn=fs-main.htm&2.0 
 
38-52-101. Colorado coordinate system zones defined.  
38-52-102. Colorado coordinate system names defined. 
38-52-103. Colorado coordinate system defined. 
38-52-104. Federal and state coordinate description same tract - federal precedence. 
38-52-105. Colorado coordinate system origins defined. 
38-52-106. Colorado coordinate system - use of term. 
38-52-107. Severability.  
 
All CDOT surveyed projects are tied to the NSRS and reference the Colorado Coordinate System 
of 1983. This is accomplished by first collecting and post processing survey grade accuracies on 
control monuments for Latitude and Longitude and ellipsoid height and then converting the 
Lat/Long to the NAD 83 coordinates and orthometric heights, however…. this is where the 
common reference between each and every CDOT project ends. Due to the fact that NAD 83 
zones are intended to provide state plane coordinates on a grid with an acceptable amount of 
distortion (1 part in 10,000) the state plane coordinates must be converted to ground coordinates 
in order to mean anything on the surface of the Earth. The process of converting from state plane 
to ground takes into consideration (among others things) the difference in elevation (elevation 
factor), the difference in Latitudes (scale factor), is the project situated more north south or more 
east west, is the project long and narrow or is it windy and more of a square, and other such 
physical and geometric features of the project. Once the state plane coordinates are converted to 
ground coordinates a Project Control Diagram is completed showing all the control monuments, 
the Latitudes, Longitudes, State Plane Coordinates and other Geodetic data, and the finally 
Ground Coordinates needed for construction. 
 
CDOT's GIS coordinate system references a Universal Transverse Mercator (UTM). There are 
two UTM zones in Colorado however GIS only uses one of them, zone 13. CDOT projects can be 
converted from Lat / Long or state plane to UTM, however, civil designers do not work in GIS, 
they work with AutoCAD or MicroStation drawings that are referenced to ground coordinates 
which would require a fair amount of work to convert back to state plane, Lat / Long and then to 
UTM. The work would be in defining each conversion parameter for individual projects as each 
project would have to be converted separately. 
 
In conclusion…. CDOT projects have a common coordinate system as described above, that is 
Latitude / Longitude and state plane coordinates, and they can be converted to other coordinate 
systems, however project plans (e.g. AutoCAD or MicroStation drawings) and all of the other 
drawings (such as bridge) are on ground coordinates converted from state plane specific to the 
project. 
 
I would like to emphasize that what you are proposing to do can be done, however one would 
have to have a solid understanding of the principles of geodesy and understand how to convert 
between various coordinate system. 
 
If you are in need of further assistance there are places you can go within CDOT for help, the 
Survey Activities Committee is probably your best source of survey and geodetic information, 
there is also the GPS/GIS Users Group, of course you could always contact a region survey 
coordinator, (Region 4 Mark Guerrero to find out specific project info about I-25 North) however 
with their time being limited working through a group is probably best.  
 
(Another topic not discussed above that you will need to pay attention to is GPS equipment and 
accuracies) 
 



Misc-Survey
Survey Manual Chapter 9

Did you know that the survey section under the CADD website has been updated with the Survey manual 
Chapter 9, and the TMOSS code book (although some minor changes to the code book have been made 
since this posting). If you have any comments on Chapter 9 contact Dan Smith.  

 

file:////public/CADD/WebFiles/Library/Manuals/survey/InRoads%20Survey%20Coding%20System%20Codebook%208-11-05.pdf
file:////public/CADD/WebFiles/Library/Manuals/survey/InRoads%20Survey%20Coding%20System%20Codebook%208-11-05.pdf
file:////public/CADD/WebFiles/Library/Manuals/survey/SM%20Chapter9%20Draft7.pdf


Title Sheet Map Inset Request 
7/28/2005 

By David Reeves 
 

This document’s purpose is to educate a Titlesheet Map requestor of what is involved 
when they request a Titlesheet Map for their Titlesheet in CAD.  It also describes what 
type of file will be returned.  For requestors that have access to the GIS program called 
Maps2, there is a step by step instruction on how they can create their own titlesheets.   
 
The document is broken into four sections. 
1. Titlesheet Overview 
2. Titlesheet Request 
3. Making the Titlesheet map using Maps2 
4. GIS GeoProcessing Model (for the GIS Analyst to read) 
 

1. Titlesheet Overview 
A titlesheet is the first page of a project CAD design package.  Currently CAD designers 
use MicroStation and InRoads.  The titlesheet page consists of many details and 
information describing the project.  One component of the titlesheet is the map inset.  The 
vector (the drawing portion) information currently comes from the GIS section when a 
requestor asks for it but it loses its GIS intelligence in the conversion.  We return a CAD 
DXF file that has the following layers: 

• GIS_HIGHWAYS 
• GIS_MAJOR_ROADS 
• GIS_LOCAL_ROADS 
• GIS_RAMPS_FRONTAGE_ROADS 
• GIS_CITIES 
• GIS_BRIDGES – Point feature 
• GIS_PLSS 
• GIS_STREAMS 
• GIS_LAKES 
• GIS_RAIL_LINES_100K 
• GIS_MILEPOINTS 

NOTE:  There is no text in the DXF file since in a GIS we let the software pick where to 
place the labels. 
 
 
 



2. Titlesheet Request 
This section defines what a requestor should request.  When a request is initiated, 
someone in the GIS section will copy and paste this section in an email or just send this 
whole document to the requestor to fill out. 
 

Titlesheet Request form 
 
Please fill out the following section if you are going to request the GIS section to send 
you the GIS data for the county where your project is in.  You will be receiving a CAD 
DXF file GIS_Titlesheet_<County>.dxf with all the GIS data in separate layers.  You 
will only have the vector linework.  There will not be any text in the CAD file and all the 
layers will have the same linetype, weight and color set.  You will have to clip out your 
area of interest, set up your layer properties and anything else that you do in CAD. 
 
Alternatively, you can use Maps2 to create the map and export it as an image that you can 
bring into MicroStation.  For more details, go to Section 3 - Making the Titlesheet map 
using Maps2. 
 
Please complete the following. 
Name: __________________________________________________ 
Department: _____________________________________________ 
Email: __________________________________________________ 
Phone: __________________________________________________ 
Project Route (i.e. 025A): ___________________________________ 
From reference point (miles): _______________________________ 
To reference point (miles): _________________________________ 
Project in these county(s): __________________________________ 
Required Date (allow at least 3 to 5 days): ______________________ 
 
Are there any additional GIS layers that you desire that are not in the following list?  
Please specify by the name that layer appears in any of the GIS applications that the GIS 
section supports such as Maps2 or the Straight Line Diagram. 

• HIGHWAYS 
• MAJOR_ROADS 
• LOCAL_ROADS 
• RAMPS_FRONTAGE_ROADS 
• CITIES 
• BRIDGES – Point feature 
• PLSS 
• STREAMS 
• LAKES 
• RAIL_LINES_100K 
• MILEPOINTS 



3. Making the Titlesheet map using Maps2 
The purpose of this section is to give instructions for someone to create a titlesheet in 
Maps2 GIS.  If you do not have Maps2 installed contact Alice Moy and she will get you 
set up.  We also provide a one day class at head quarters and Alice handles the 
registration for that class as well.  She can be reached at 303-757-9523 or 
alice.moy@dot.state.co.us. 
 

 Figure out where your project is.  You will need to know the County, Route and 
the reference point range in miles.  For this example I’m going to use Interstate 
I25 (Route: 025A) from MP 188 to MP 192 in Douglas County. 

 Click the Build New View button . 
 Clicking the Counties… button on the Select View Type dialog. 

 
 Select the county that your project is in.  For this example select DOUGLAS.  



 
 Turn on all the layers that you want on your map. (i.e. Bridges, Ramps/Ftg Roads, 

Highways, Major Roads, Minor Roads, Streams, Lakes, Cities, PLSS, County 
Line) 

 Change symbols if you wish or just accept the defaults. 
 Zoom to your area of interest by activating Highways in the table of contents and 

using the Zoom to Feature function (View > Zoom to Feature…).  Enter in your 
project Route and Reference Points in Miles that you collected in step one.  

 
 Make a copy of highways in your view so it appears twice by activating 

Highways and then click Edit > Copy Themes and then Edit > Paste. 
 Activate the top copy of Highways and then click Theme > Properties. 
 Change the Theme Name to something different such as Hwy Project 123. 



 
 Use the Maps2 function Set Definition to Selection (Theme > Set Definition to 

Selection) on the Highway copy you just made. 
 Change the color and line thickness to differentiate it from the other highway 

layer.  Try a line thickness of 4 with the color green. 
 Label all the features that you wish using the Label tool  or Auto Label (Read 

ArcView help if you don’t know how to label.  Just go to Help > Help Topics 
with the keyword Label).   

Note: You should set the symbol properties on the Symbol Pallete (Ctrl-P 
or Window > Show Symbol Window) before creating a label so that labels 
get placed with a size and color that you specify rather than the same 14 pt 
Arial font.   

o For this example I labeled the following layers all using Arial font: 
 PLSS Sections – Size 14, Bold, Magenta 
 PLSS Township Name (Tname) – Size 14, Bold Italic, Magenta 
 Major Roads – Size 12, Bold, Black 
 Streams – Size 7, Italic, Navy Blue 
 Cities – Size 14, Bold, Black 
 Bridges – Size 12, Normal, Black 
 Ref Points – Size 12, Bold, Black 

 Project call out box using the Callout Text tool . 
 Highways - Label the highways using one of the Highway Label 

tools.  Click and hold the Label tool for the other tools to appear. 



 



 You should now have a map similar to the following: 

 
 Export your map to image file – When your map is complete export your view 

to an image file (File > Export ).  I recommend using the image default type of 
Placeable WMF and increasing the resolution to 144 DPI by clicking the Options 
button.  The advantage of the WMF is that the white background is clear rather 
than white so you can layer with other WMF in CAD or with your own CAD 
objects. 

 



 The following image is what I exported as a WMF file and then inserted into this 
MS Word document.  I imagine that Micro Station works the same way. 
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4. GIS GeoProcessing Model (for the GIS Analyst to 
read) 

 
This section is only relevant to the GIS Section or to someone with access to 
the ESRI ArcCatalog program and SDE.  It is included so that a GIS Analyst 
can refer to this document when a request is received so that they can 
recreate a titlesheet in a repeatable and uniform manner. 

 
The following two diagrams illustrate the ESRI GeoProcessing model that is stored in 
SDE.  Database Connections\HQDEVARCSDE01.PUB_BETA.sde, 
PUB_BETA.TITLESHEET\CREATE_TITLESHEET. 
 

 
 
The model has four parameters. 

• Select Features – The default is the Counties polygons but it can be changed to 
any other polygon layer. 

! 



• Expression – This expression is based on the previous Select Feature.  It is a 
query to only select the features in your area of interest so that a Select by 
Location can be made. 

• CAD File – The name of the CAD file that will be created.  Remember to include 
DWG for AutoCAD files. 

• Output Type – The default is DXF. 
 
Just run this model and a single CAD file will be created with all the relevant layers.  
They will not be symbolized and linetypes will not be set.  That is up to the CAD 
Technician/Engineer. 



MicroStation 

Using AutoTrack 

Did you know that if you have Autotrack loaded on your machine, the following 
workflow can be used...

1. Under AddOn's Launch AutoTrack

2. Should get dialog box and main AutoTrack toolbar.

3. Click on the truck to pick design vehicle.

4. Set Active level to place new path.

5. Click on AutoDrive icon.

6. Place vehicle in starting position and bearing.

7. Dialog box shows up, click on the icon with the red circle & number 5 to set speed 
or other properties.

8. Click Proceed when ready to set path. Click where you want the vehicle to move. 
Reset when finished (follow prompts).

Tip: Click on the icon with the pencil and the AutoTrack Path Edit toolbar opens. The 
icon on the far right allows you to delete last target point.

Tip from Jim Biren, R2 
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